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Reverse Engineering Malware: Why
You Should Study Reverse Engineering
Malware

[ am about to embark upon probably the most technically demanding tutorial series,
Reverse Engineering Malware. Before I do so, I thought I would take a few moments to
explain why you should study and invest your time into reverse engineering. Please take
a moment to read the following and then, hopefully, decide whether this discipline is
worth your time to advance your career in cyber security.
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What is Reverse Engineering Malware?

In this series, we will be dissecting known malware to understand how it works, its
operation and its "signature". According to the Merriam-Webster dictionary, reverse
engineering is defined as "disassemble or analyze in detail in order to discover concepts
involved in manufacture". That is precisely my intent with this series, to analyze in
detail to discover concepts involved in manufacture” of malware.

Furthermore, Wikipedia defines reverse engineering as;

the process of discovering the technological principles of a(n)...application through
analysis of its structure, function and operation. That involves sometimes taking something
apart and analyzing its workings in detail, usually with the intention to construct a new
device or program that does the same thing without actually copying anything from the
original. (my emphasis added)



We will be using a number of different tools in this analysis including virtual machines,
sandboxes, unpackers, disassemblers and debuggers to do so. Wherever possible, [ will
use free and open source tools.
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Why Reverse Engineering Malware?

#1 To Gain a Deeper and More Thorough Understanding of Applications and
Operating Systems

If nothing else, by reverse engineering malware, you will gain a deeper and more
thorough understanding of the operating systems and applications. Malware must use
and exploit these operating systems and applications for it's own malicious purposes
and by dissecting the malware and its operation, you can better understand not only
how the malware works, but the functioning of the OS and apps.

#2 Train to Work in Forensic Malware Analysis

Presently, the highest paid and most in-demand sub-discipline in digital forensics is for
those capable of dissecting malware and using this information for attribution. When
new malware appears, it is most often those that can reverse the malware that are
commissioned to attribute its source. This becomes increasingly important in the fields
of cyber espionage and cyber warfare between nation states.

By reading and studying this series, Reverse Engineering Malware, you will begin your
preparation for this rewarding career.



#3 Build Security Applications

Before can even begin to build security applications to protect systems, you first need to
understand how the malware works. Whether working in Intrusion Detection Systems
(IDS) development, AV software, firewalls or the latest Artificial Intelligence (AI) based
security systems, you must have an understanding how the malware functions and,
therefore, how it can be detected and neutralized.

#4 Be Better Prepared as a Forensic Analyst or Incident Response Handler

Reverse Engineering Malware will help incident responders and forensic
analysts/investigators to assess quickly the severity of a breach to better plan for
recovery. By studying reverse engineering of malware, the forensic investigator can
establish the key indicators of a compromise and then plan for containing and
recovering from an incident.

# 5 Build Your Own Zer0-Day Exploits

The "Holy Grail" of any security researcher, hacker or pentester is to develop a zer0-day
exploit. Whether you are a White Hat trying to develop a proof-of-concept (POC) exploit,
a Bug Bounty Hunter, or a Black hat looking to exploit the latest new app, you must
understand the inner workings of the operating system, the app and probably, the
previous malware that has been developed. In this series, we will explore the inner
workings of some common operating systems and applications and some malware that
has successfully exploited those systems. By learning how these systems have been
compromised in the past, you will have a better concept of how to develop your own. In
addition, like all software development, it does not make any sense to "reinvent the
wheel". All software developers re-use code to save time and money. This applies
equally to malware developers (that code re-use can often provide evidence towards
attribution). Here, we will study some common and successful malware over the years,
many of which have modules that can be re-used.

Without the ability to build your own exploits, your career as a pentester/hacker will be
largely limited to running other peoples' code. To reach the highest echelons of the
security/pentesting industry you will need to understand previously deployed malware
and develop your own.



Some of the subjects we will address in this series include;

e Assembly Language Review

¢ Introduction to Malware Analysis
¢ Reversing with Disassemblers

¢ Reversing with a DeBugger

e User Mode Debuggers

e Reversing Win32 with IDA Pro

e Reversing Stacks and Heaps
Windows Internals

Linux Internals

Reversing Data Structures
Structured Exception Handling
System level Reversing
Reversing Bots

Reversing Infection Vectors
Encoders and Compressors
Auditing Binaries

Binary Diffing

Reversing Encryption

Detecting Debuggers and Disassemblers



Reverse Engineering Malware, Part 1:
Getting Started

Let's get started!

Reverse Engineering malware is a deep and sophisticated subject matter, hence few
people actually master it. This is the primary reason why the salaries in this field are SO
high. Before we proceed, we need to develop a conceptual framework and elaborate of
some strategies and issues relating to reverse engineering malware. So, let' s do that
first.

What is Reversing Engineering?

Although definitions vary a bit about what exactly is reverse engineering, in this series
we will trying to determine what a piece of software (malware) does even when we
don't have access to the source code (usually the case). After determining what the
software does, then we will attempt to (1) either tweak it to do something slightly
different or (2) re-construct it in another piece of software (malware).

Reverse Engineering Applied to Malware

Reverse engineering is used on both termini of malware development and delivery. At
the developer terminus, reverse engineering is used to find vulnerabilities in operating
systems and applications that the malware can exploit. In addition, the developers can
use reverse engineering to find and use a module from someone else's malware. Like all



software developers, malware developers re-use useful code from others' software. No
sense in re-inventing the wheel even when doing malware development.

At the other terminus, forensic investigators and incident handlers can use reverse
engineering to trace what a piece of malware does and what harm it might bring.
Furthermore, reverse engineering can often give the forensic investigator a clue to the
origin and attribution of the malware.

Low Level Software

In reverse engineering software, we often are working in low-level software. The source
code is most often not available to us, but the low-level software always is.

Assembly Code

Assembly is the lowest level in the software chain and although we don't have access to
the source code, various tools can reduce the source code to assembly. Each instruction
in any higher level language must be visible to the assembly language code. There is no
magic here, each instruction must be reduced to one or more assembly instructions. In
most cases, we will be working with this simple assembly code when reverse
engineering.

Obviously, to be successful at reversing, we must be familiar with assembly language
code. Unfortunately, there is not a single assembly language, but rather an assembly
language for each type of processor (x86, x64, ARM, PPC, etc). To master reversing, we
must master the assembly code of our chosen platform. In this series, we will be
examining x86, x64 and ARM assembly.
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Machine Code

Machine code or binary code is the code read by the CPU. Machine code and assembly
are two different representations of the same thing. Machine code is simply a sequence
of bits that contain instructions for the CPU.

Assembly language is simply textual representation of machine code that makes them
more easily human readable (but not much more). Each assembly language command is
represented by a number called the opcode, short for operation code.

Compilers

Compilers convert source code into machine code. One of the biggest challenges in the
reversing process is that compilers tend to optimize the code to make it more efficient
and perform better. Therefore, the same code compiled by two different compilers will
actually generate slightly different machine code making our job of reversing more
difficult.

The Reversing Process

The reversing process can usually be broken down into at least two types; (1) code level
and (2) system level.

Code Level

When we do code level reversing, we are attempting to extract the software's code
concepts and algorithms from the machine code. This requires a solid understanding of
such things as how the CPU works, how the operating system works and the process of
software development. We will be using such tools as IDA Pro, Softlce, Ollydbg, Ghidra
and some others in this process.
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System level

System level reversing involves running tools to obtain information about the software,
inspect the program, inspect the executables, and track the program's input and output.
Most of this information will come from the operating system. We will be using such
tools as SysInternals Suite, Tripwire, Isof, Wireshark, and others.
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Reversing Tools

Reverse Engineering tools can be broken down to several categories. These include;
(1) System-level Tools

These tools sniff, monitor and explore the software we are examining. In most cases,
they use the operating system to gather info on the malware.

(2) Disassemblers
Disassemblers take the software and generate the assembly code for the program. In

this way, we can examine the inner workings of the malware without seeing the source
code.
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(3) Debuggers

A debugger enables us to observe a program while it is running. It enables us to set
breakpoints and trace through the code.

(4) Decompilers

A decompiler attempts to take an executable and re-create the source code in a high-
level language. Although imperfect due to the fact that compilers vary and omit steps for
efficiency, this can still be a productive process in the reversing discipline.

Legality

The legality of reverse engineering has always been controversial. The question of
legality revolves around the issue of the social and economic impact of reverse
engineering. For instance, if you were to reverse engineer Microsoft's Excel and then re-
sell it, that would very likely be deemed illegal. If you are reverse engineering malware
to decipher its capabilities and origins, that will likely be deemed legal.

Copyright law and the Digital Millenium Copyright Act (DMCA) are key pieces of
legislation pertinent to reverse engineering. Some have claimed that creating an
intermediate copy of a software program during the reverse engineering process is in
itself a violation of the Copyright law. Fortunately, the courts have disagreed.

On the other hand, the DMCA protects copyright protected systems from being copied. In
almost every case, circumvention of DMCA protections involves reverse engineering. We
will look at a few of those ways in this course of study.

Copyright protections usually involve Digital Rights Management technology and
circumvention of these systems is ALWAYS illegal even for personal use. It is illegal even
to develop or make available such means to circumvent DRM.

There is an exception, however. You may reverse and circumvent copyright protection
on software for the purpose of evaluating or improving the security of a computer
system. It is this exception that our work falls within.

Conclusion
[ hope that this introduction has given you a framework for understanding the reverse

engineering malware process and has whet your appetite for what is to come. Keep
coming back as I step your through the exciting process of reverse engineering malware!



Reverse Engineering Malware, Part 2:
Assembler Language Basics

Most of the work we will be doing in reverse engineering will be with assembler
language. This simple and sometimes tedious language can reveal a plethora of
information on the source code. When we can't see or recover the source code of the
malware or other software, we can use tools such as dis-assemblers and debuggers to
recover the underlying assembler of the software. From there, of course, we can then
decipher what the software was attempting to do.

In this tutorial, I will simply be listing the most basic and fundamental assembler
instructions. [ suspect most of you will simply use it a a reference as we progress though
this study, so make certain to bookmark this page so that you can easily come back to it.

Vo) G P | Y

-
r 0088000008404040 mOVZX eax, word [ds:rbx+0x20) ; XREF=sub_403ded4+664
0000000000404044 test ax, ax
0000000000404047 mov word [ss:rsp-8x88+var_5A], ax
000000000040404C je 0x404060
000000000040404e mov rg, rbx ; argument #3 for met
0800000000404051 mov edx, Ox1 ; argument #2 for met
0000000008404056 mov rex, ri3 ; argument #1 for met
0002200000404059 call sub_402da®
000000000040405¢ nop
e 0000000000404060 cmp rsi, rbp ; XREF=sub_403ded+616
0000000000404063 je 0x40418f
0082000000404069 sub rsi, ox1 ; XREF=sub_403de4+595
0008000000040406d mOVSX ecx, byte [ds:rsi]
0000000000404070 cmp ecx, @x2e
0020000000404073 je ©x4041d2
0200000000404079 cmp ecx, Ox2c
. 008000000040407¢C je 2x404040

Let's begin some every basic concepts. Hopefully, this all review for you, but if not, you
need to understand these basic concepts before proceeding in this course of study.

Bit - This is the smallest piece of data. It can be a 0 or 1 or Off or ON.

Byte - a byte is 8 bits. It has a range of equivalent decimal values of 0 to 255
Word - a word is two bytes together or 16 bits

Double Word - a double word is tow words or 32 bits

Kilobyte - a kilobyte is 1024 (32 * 32) bytes

Megabyte - a megabyte is is 1,048,578 bytes (1024 x 1024).

Registers

Registers are places in computer memory where data is stored. When working in the
assembler, we are usually using these registers to move and manipulate information, so
you should be familiar with them.



The Intel 32-bit x86 registers:
[ e ][ e ]

accumulator stack pointer
— e —
base pointer
_ [ e
counter source index
[ ex ][ em ]
data destination index
-
instruction pointer

These registers are;

EAX - Extended Accumulator Register
EBX - Extended Base Register

ECX - Extended Counter Register
EDX - Extended Data Register

ESI - Extended Source Index

EDI - Extended Destination Index
EBP - Extended Base Pointer

ESP - Extended Stack Pointer

EIP - Extended Instruction Pointer



Flags

Flags are a single bit that indicates status of a register. The flag register on modern 32
bit CPU's is 32 bits long. There are 32 flags. In our studies here, we will only need three
of them; (1) the Z flag, the O flag and the C flag.

A flag can only be SET or NOT SET

Z-Flag

The Z-flag (zero flag) is the most useful flag for cracking. It is used in about 90% of all
cases. It can be set or cleared by several opcodes when the last instruction that was
performed has 0 as a result

O-Flag

The O-flag (overflow flag) is used in about 4% of all cracking attempts. It is set when the
last operation changed the highest bit of the register that gets the result of an operation.

C-Flag

The C-Flag (carry Flag) is used in about 1% of all cracking attempts. It is set, if you add a
value to a register, so that it gets bigger than FFFFFFFF or is you subtract a value so that
the register value is less than zero.

Stack

The stack is a part of memory where you can store different things for later use. Like a
stack of books on a desk where the last on top (last in or LI) is the first to leave (LIFO).
This will be the

o/ A
1 g 2 g
first object to

e AL come out.
1 1

Empty Stack

The command PUSH saves the contents of a register on the stack. The command POP
grabs the last saved contents of a register from the stack and then places it into a specific
register.



Instructions

Assembler language has a small number of fundamental commands. These include;
ADD - The ADD instruction adds a value to a register or memory address.

Syntax:
ADD destination, source

AND - the AND instruction uses a logical and on two values

Syntax:
AND destination, source

CALL - the CALL instruction pushes the Relative Virtual Address (RVA) of the instruction
that follows to the stack and calls a subprogram or sub-procedure

Syntax:
CALL something

CDQ - Convert DWORD to QWORD (Convert D to Q)

Syntax:
CDQ

CMP - Compare

the CMP instruction compares two things and can set the C/0/Z flags if the result
of the compare fits

Syntax:
CMP destination, source

DEC - Decrement

the decrement command is used to decrease a value
decreases a value (value= value -1)

Syntax:
DEC something

DIV - Division

the DIV command is used to divide EAX through a divisor. The dividend is always
EAX, the result is stored in EAX and the modulus is stored in EDX.

Syntax:
DIV divisor



IDIV - Integer division. Signed division and may set C/0/Z flags

Syntax:
IDIV divisor

IMUL - integer multiplication

Syntax:

IMUL value

IMUL dest, value, value
IMUL dest, value

INC - increment, opposite of DEC instruction (value = value +1)

Syntax:
INC register

INT - the INT command generates a call to an interrupt handler
JUMPS - there are a variety of jumps, but the most common and important jumps are;

JE - jump if equal

JG - jump if greater

JGE - jump if greater or equal
JL - jump if lesser

JLE - jump if less or equal
JMP - jump always

JNE - jump if not equal

JNZ - jump if not zero

JZ - jump if zero

LEA - Load Effective Address

Syntax:
LEA destination, source

MOV - move copies the value from the source to the destination

Syntax:
MOV destination, source

MUL - multiply is the same as IMUL but it multiplies unsigned

Syntax:
MUL value



NOP - no operation does nothing

Syntax:
NOP

OR - logical inclusive OR

Syntax:
OR destination, source

POP - the POP instruction loads the value of the byte/word/dword pointer (ESP) and
puts it into the destination.

Syntax:
POP destination

PUSH - the PUSH instruction stores a value on the stack and decreases it by the size of
the operand that was pushed, so that the ESP points to the value that was PUSHed.

Syntax:
PUSH operand

REP - repeat following string instruction. Common uses are REPE(repeat if equal), REPZ
(repeat if zero), REPNE (repeat if nonequal), and REPNZ (repeat if non-zero)

Syntax:
REP ins
Where ins is a string operation

RET - return

Syntax:
RET digit

SUB - subtraction. Is the opposite of ADD command. Subtracts the value of the source
from the value of destination and stores the result in destination

Syntax:
SUB destination, source

TEST - it performs a logical AND but does not store the value

Syntax:
TEST operand1 , operand?2



XOR - the XOR instruction connects two values using logical exclusive OR

Syntax:
XOR destination, source

Logical Operations

The table below summarizes the logical operations displaying the results of AND, OR,
NOT and XOR when the source or destination isa 1 or 0.

Operation Source Destination Result

AND

OR

XOR

NOT




Reverse Engineering Malware, Part 3:
IDA Pro Introduction

There are many tools available for reverse engineering, but one disassembler stands
alone. Nearly everyone in this industry uses IDA Pro to some extent. IDA Pro is a
disassembler capable of taking binary programs where we don't have the source code
and creating maps and multiple modes of understanding the binaries. It takes source
code and represents it as assembler code, so that we can better understand how the
original code works. IDA Pro also has a a debugger, but we will focus primarily on its
disassembly capabilities in this course.

IDA (Interactive Disassembly) Pro was first developed by Ilfak Guilfanov and sold now
by his Leige, Belgium based firm, Hex-Rays. IDA Pro comes in a Windows version (which
we will be using here) as well as Linux and MacOS versions.

Let's get started with IDA!


http://www.hackers-arise.com/post/2017/02/27/Reverse-Engineering-Malware-Part-2-Assembler-Language-Basicshttps

Step #1 Download and Install

IDA Pro is commercial software, but you can download either the free version or the
demo/evaluation version for this course. These versions have some limitations such as;

(1) they will only work on x86 and ARM platforms
(2) they will only work on PE/ELF/Macho-0 formats
(3) you can not save your results and it may time out
(4) a few other limitations.

After downloading IDA Pro, accepting the license agreement, installing Python 2.7, and
installing Microsoft Visual C++, IDA pro will install to your system. It should now be in
your programs at the Start button in Windows. Locate it and click on the icon. When you
do so, IDA will start up with a screen like below. Click on "New".

Disassemble a new file

E \Work on your own

Load the old disassembly

V] Display at startup




Step #2 Load a PE File

Since we are working with the demo version, we can only use Portable Executable (PE)
files. We can now drag and drop a file into the working center window or click on File ->
Open.
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After selecting a file to disassemble and analyze, the window below will pop up. As you
can see, IDA was able to automatically determine the type of file (portable executable)
and processor type (x86). Click on "OK."
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When IDA begins its disassembly and analysis, it analyzes the entire file and places the
information into a database. This database has four files:

1. .id0 - contains contents of B-tree-style database

2. .id1 - contains flags that describe each program byte

3. .nam - contains index information related to named program locations
4. .til - contains information about local type definitions

Whenever you go to close IDA4, it will ask you whether you want to save these database
files. If you do, these four files will be archived into a single IDB file. When people refer
to the IDA database, this is what they are referring to. These files will be saved and
available to you at any time. You will see these files saved in the same directory as the
file you are analyzing.

Step #3 Start the Disassembly

In this lab, I will be using small .exe file that is part of the Acunetix Web Vulnerability
scanner. Its not malware, but it makes a good beginner demo. You can use any portable
.exe (PE) that is 32-bit, so the demo version of IDA Pro can disassemble it. When we
open it, IDA Pro begins its disassembly process and displays the information like in the
screenshot below.
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As you can see above, IDA provides us with some basic info in the IDA View tab. If we
scroll down the IDA View, we can see every line of code. This is where we will do most
of our work when we begin malware disassembly and analysis.



If we right-click, it displays the window shown below. Note that we can select Text View
or any number of other options while in the IDA View. When we begin our analysis later
in the course, we will be setting breakpoints in the code, F2.
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Font...
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The colorful bar above this IDA View represents the memory that the file is occupying. It
color codes for the different parts of the program that are stored in each part of memory.
If we right-click any part of the memory bar, we can zoom in to that segment of the code

stored in memory. We are capable of zooming in right down to the single byte level.
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We can view the file from many different perspectives by selecting any of these views
available. These include the IDA View (as seen here), Hex View, Structures, Enums,
Imports, and finally, Exports. By clicking on any one of those tabs, it will give us that
particular view of the code (see Import in Step 5 below).
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One of the most interesting and enlightening views that IDA can provide us is the flow
chart. The flow chart graphically displays the flow of the execution of the file, making it
easier to understand. We can open it by going to the top menu bar and clicking on View -
> Graphs -> Flow Chart. It will open a Flow Chart of the code similar to that below.
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We can zoom in by going to the View menu at the top of the flow chart to get greater
detail. In this way, we can view the program flow from each register, subroutine, and
function.
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Step 5: Show Imports

When we select the Imports view, IDA will show us all the modules that the .exe
imported. These imports can give us clues as to the origin of the malware.
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Step 6: Customize the Analysis

Finally, we can begin to customize what and how IDA displays the code to by going to
Options -> General. A window like that shown in the screenshot below will enable us to

customize our analysis.
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Although this far from a complete and thorough introduction to IDA Pro, we are ready to
use IDA Pro for some malware analysis! I will introduce additional concepts and
techniques as you need them throughout the course.

Before you proceed, I think it is useful to introduce you to a few key commands and

shortcuts in IDA Pro.

Text search Alt+T
Show strings window Shift+F12
Show operand as hex value 8]
Insert comment

Follow jump or call in view Enter
Return to previous view Esc
Go to next view Ctrl+Enter
Show names window Shift+F4
Display function’s flow chart F12
Display graph of function calls Ctrl+F12
Go to program'’s entry point Ctrl+E
Go to specific address G
Rename a variable or function N
Show listing of names Ctrl+L
Display listing of segments Ctrl+S
Show crms.—réferences to Select function
selected function name » Ctrl+X
Show stack of current function Ctrl+K

Also, please find a complete IDA Pro Quick Reference sheet courtesy of the good folks at
www.datarescue.com (the original sales and marketing firm for IDA Pro).



Datarescue
Interactive Disassembler (IDA) Pro
Quick Reference Sheet
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Reverse Engineering Malware, Part 4:
Windows Internals

In general, reverse engineering of malware is done on Windows systems. That's because
despite recent inroads by Linux and the Mac OS, Windows systems still comprise over
90% of all computing systems in the world. As such, well over 90% of malware is
designed to compromise Windows system. For this reason, it makes sense to focus our
attention to Windows operating systems.

When reversing malware, the operating system plays a key role. All applications interact
with the operating system and are tightly integrated with the OS. We can gather a
significant amount of information on the malware by probing the interface between the
OS and the application (malware).

To understand how malware can use and manipulate Windows then, we need to better
understand the inner workings of the Windows operating system. In this article, we will
examine the inner workings or Windows 32-bit systems so that we can better
understand how malware can use the operating system for its malicious purposes.
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Windows internals could fill several textbooks (and has), so I will attempt to just cover
the most important topics and only in a cursory way. I hope to leave you with enough
information though, that you can effectively reverse the malware in the following
articles.



Virtual Memory

Virtual memory is the idea that instead of software directly accessing the physical
memory, the CPU and the operating system create an invisible layer between the
software and the physical memory.

The OS creates a table that the CPU consults called the page table that directs the
process to the location of the physical memory that it should use.

Processors divide memory into pages

Pages are fixed sized chunks of memory. Each entry in the page table references one
page of memory. In general, 32 -bit processors use 4k sized pages with some exceptions.

page 0

page 1

page 2 .

[\

memory

page v physical
memory

virtual
memory



Kernel v User Mode

Having a page table enables the processor to enforce rules on how memory will be
accessed. For instance, page table entries often have flags that determine whether the
page can be accessed from a non-privileged mode (user mode).

In this way, the operating system's code can reside inside the process's address space
without concern that it will be accessed by non-privileged processes. This protects the
operating system's sensitive data.

This distinction between privileged vs. non-privileged mode becomes kernel
(privileged) and non-privileged (user) modes.

Kernel memory Space

The kernel reserves 2gb of address space for itself. This address space contains all the
kernel code, including the kernel itself and any other kernel components such as device
drivers.
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Paging is the process where memory regions are temporarily flushed to the hard drive
when they have not been used recently. The processor tracks the time since a page of



memory was last used and the oldest is flushed. Obviously, physical memory is faster
and more expensive than space on the hard drive.
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The windows operating system tracks when a page was last accessed and then uses that
information to locate pages that haven't been accessed in a while. Windows then flushes
their content to a file. The contents of the flushed pages can then be discarded and the
space used by other information. When the operating system needs to access these
flushed pages, a page fault will be generated and then system then does that the
information has "paged out" to a file. Then, the operating system will access the page file
and pull the information back into memory to be used.

Objects and Handles

The Windows kernel manages objects using a centralized object manager component.
This object manager is responsible for all kernel objects such as sections, files, and
device objects, synchronization objects, processes and threads. It ONLY manages kernel
objects.

GUI-related objects are managed by separate object managers that are implemented
inside WIN32K.SYS.

Kernel code typically accesses objects using direct pointers to the object data structures.
Applications use handles for accessing individual objects.

Handles

A handle is process specific numeric identifier which is an index into the processes
private handle table. Each entry in the handle table contains a pointer to the underlying
object, which is how the system associates handles with objects. Each handle entry also
contains an access mask that determines which types of operations that can be
performed on the object using this specific handle.



Processes

A process is really just an isolated memory address space that is used to run a program.
Address spaces are created for every program to make sure that each program runs in
its own address space without colliding with other processes. Inside a processes'
address space the system can load code modules, but must have at least one thread
running to do so.

Process Initialization

The creation of the process object and the new address space is the first step. When a
new process calls the Win32 API CreateProcess, the API creates a process object and
allocates a new memory address space for the process.

CreateProcess maps NTDLL.DLL and the program executable (the .exe file) into the
newly created address space. CreateProcess creates the process's first thread and
allocates stack space it. The processes first thread is resumed and starts running in the
Ldrplnitialization function inside NTDLL.DLL

Ldrplnitialization recursively traverses the primary executable's import tables and
maps them to memory every executable that is required.

At this point, control passes into LdrpRunlnitializeRoutines, which is an internal
NTDLL routine responsible for initializing all statically linked DLL's currently loaded
into the address space. The initialization process consists of a link each DLL's entry point
with the DLL_PROCESS_ATTACH constant. Once all the DLL's are initialized,
Ldrplnitialize calls the thread's real initialization routine, which is the
BaseProcessStart function from KERNELL32.DLL. This function in turn calls the
executable's WinMain entry point, at which point the process has completed it's
initialization sequence.



Threads

At ant given moment, each processor in the system is running one thread. Instead of
continuing to run a single piece of code until it completes, Windows can decide to
interrupt a running thread at given given time and switch to execution of another
thread.

A thread is a data structure that has a CONTEXT data structure. This CONTEXT includes;

(1) the state of the processor when the thread last ran

(2) one or two memory blocks that are used for stack space

(3) stack space is used to save off current state of thread when context switched
(4) components that manage threads in windows are the scheduler and the
dispatcher

(5) Deciding which thread get s to run for how long and perform context switch
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Context Switch

Context switch is the thread interruption. In some cases, threads just give up the CPU on
their own and the kernel doesn't have to interrupt. Every thread is assigned a quantum,
which quantifies has long the the thread can run without interruption. Once the
quantum expires, the thread is interrupted and other threads are allowed to run. This
entire process is transparent to thread. The kernel then stores the state of the CPU
registers before suspending and then restores that register state when the thread is
resumed.



Win32 API

An APl is a set of functions that the operating system makes available to application
programs for communicating with the OS. The Win32 APl is a large set of functions that
make up the official low-level programming interface for Windows applications. The
MFC is a common interface to the Win32 API.

The three main components of the Win 32 API are;

(1) Kernel or Base API's: These are the non GUI related services such as I/0,
memory, object and process an d thread management

(2) GDI API's : these include low-level graphics services such a s those for
drawing a line, displaying bitmap, etc.

(3) USER API's : these are the higher level GUI-related services such as window
management, menus, dialog boxes, user-interface controls.

System Calls

A system call is when a user mode code needs to cal a kernel mode function. This usually
happens when an application calls an operating system API. User mode code invokes a
special CPU instruction that tells the processor to switch to its privileged mode and call a
dispatch routine. This dispatch routine then calls the specific system function requested
from user mode.



PE Format

The Windows executable format is a PE (Portable Executable). The term "portable
refers to format's versatility in numerous environments and architectures.

Executable files are relocatable. This means that they could be loaded at a different
virtual address each time they are loaded. An executable must coexist with other
executables that are loaded in the same memory address. Other than the main
executable, every program has a certain number of additional executables loaded into its
address space regardless of whether it has DLL's of its own or not.
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Relocation Issues

If two executables attempt to be loaded into the same virtual space, one must be
relocated to another virtual space. each executable is module is assigned a base address
and if something is already there, it must be relocated.

There are never absolute memory addresses in executable headers, those only exist in
the code. To make this work, whenever there is a pointer inside the executable header, it
is always a relative virtual address (RVA). Think of this as simply an offset. When the file
is loaded, it is assigned a virtual address and the loaded calculates real virtual addresses
out of RVA's by adding the modules base address to an RVA.

Image Sections

An executable section is divided into individual sections in which the file's contents are
stored. Sections are needed because different areas in the file are treated differently by
the memory manager when a module is loaded. This division takes place in the code
section (also called text) containing the executable's code and a data section containing
the executable's data.

When loaded, the memory manager sets the access rights on memory pages in the
different sections based on their settings in the section header.

Section Alignment

Individual sections often have different access settings defined in the executable header.
The memory manager must apply these access settings when an executable image is
loaded. Sections must typically be page aligned when an executable is loaded into
memory. It would take extra space on disk to page align sections on disk. Therefore, the
PE header has two different kinds of alignment fields, section alignment and file
alignment.

DLL's

DLL's allow a program to be broken into more than one executable file. In this way,
overall memory consumption is reduced, executables are not loaded until features they
implement are required. Individual components can be replaced or upgraded to modify
or improve a certain aspect of the program.

DLL's can dramatically reduce overall system memory consumption because the system
can detect that a certain executable has been loaded into more than one address space,
then map it into each address space instead of reloading it into a new memory location.
DLL's are different from static libraries (.lib) which linked to the executable.



Loading DLL's

Static Linking is implemented by having each module list the the modules it uses and the
functions it calls within each module. This is known as an import table (see IDA Pro
tutorial). Run time linking refers to a different process whereby an executable can
decide to load another executable in runtime and call a function from that executable.

PE Headers

A Portable Executable (PE) file starts with a DOS header.
"This program cannot be run in DOS mode"

typedef struct _IMAGE_NT_HEADERS {
DWORD Signature;
IMAFE_FILE_HEADER Fileheader;
IMAGE_OPTIONAL_HEADER32 OptionHeader;
} Image_NT_HEADERS32, *PIMAGE_NT_HEADERS32

This data structure references two data structures that contain the actual PE header.
Imports and Exports

Imports and Exports are the mechanisms that enable the dynamic linking process of
executables. The compiler has no idea of the actual addresses of the imported functions,

only in runtime will these addresses be known. To solve this issue, the linker creates a
import table that lists all the functions imported by the current module by their names.



Reverse Engineering Malware, Part 5:
OllyDbg Basics

In this series, we are examining how to reverse engineer malware to understand how it
works and possibly re-purposing it. Hackers and espionage agencies such as the CIA
and_NSA, regularly re-purpose malware for other purpose.

Previously, we looked at the basics of IDA Pro, the most widely used disassembler in
our industry. In this tutorial, we will look at one of the most widely used and free
debuggers, OllyDbg.

OllyDbg is a general purpose Win32 user-land debugger. It has an easy-to-use and fairly
intuitive GUI making it a relatively quick study. Although OllyDbg is free, it is NOT open
source as we do not have access to the source code. Despite this, OllyDbg has a well-
defined plug-in architecture making it easily extensible to developers who want add
capabilities to this powerful tool.

If you are using Kali or another security distribution, it is usually installed on your
system. OllyDbg will run in either Windows or Linux and, in fact, it requires WINE to run
in Linux. If you do not have OllyDbg on your system, you_can download OllyDbg here.


http://www.ollydbg.de/download.htm

Step #1: Starting OllyDbg

To start OllyDbg in Kali, go to Applications, then Reverse Engineering and finally
ollydbg, as seen in this screenshot below.
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When you do, it will open a screen like that below. Note that OllyDbg has the familiar
pull-down menu system along the top of the GUI.
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Step #2: Loading a File into OllyDbg

The next step is to load an .exe file into Ollydbg. You can do that by dragging and
dropping the file into the work area of Olly or go to the File menu at the top and select
Open. Note that the open window specifies that it must be an executable file.

I OllyDbg |
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When you click open, Ollydbg will begin the process of analyzing your code. In this case,
[ used a simple .exe that comes pre-installed on my flash drive named LaunchU3.exe for
demonstration purposes only. Obviously, it is NOT malware. In future tutorials, we will
use both malware and non-malware to debug and analyze. Debuggers such as OllyDbg
are also useful for analyzing errors (bugs) in code for developers and also breaking
authentication schemes that prevent piracy.

As you can see below, Olly, takes the code and breaks into several windows. In the upper
left window we have the virtual addresses of the instructions, in the upper right window
the CPU registers, in the lower left we have the data residing in memory and finally in
the lower right window, we have the stack. Also, please note that in the lower right,
highlighted in yellow, we have the status. In this case, it indicates that we are in "pause”
status.
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Step #3: Different Views of the Code

Status
Stack

We can get different views of our data by clicking on the view button on the top menu.
Note that each view is associated with a hotkey that is preceded by the Alt key with the
exception of "patches” which uses the Ctrl key.
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From here we can open a processes' logs (Alt+L), executables (Alt+E), memory layout
(Alt +M), windows, handles and and its breakpoints (Alt+B). Note that each of these is

also represented in the blue letters on the menu bar as shortcuts.

If we select the Executable modules (Alt+E) or the blue "E", we open a window with all
the files executables like below.The Executable Modules Window shows the base virtual
address to the far right, the virtual size of the binary in memory in the second column,
the Entry Point’s virtual address in the third column, the name of the module in the
fourth column, file version, and file path for each module loaded in the process. If the

text appears in Red, that means the module was loaded dynamically.

OllyDbg - LaunchU3.exe — [Executable modules] —0Ox
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From the executables window, we can right click and pull up a context sensitive window.
From here we can do a number of things, but let's take a look at the "View names"

window.
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Here we see all the functions and imported functions used in the program. We can also

access this window by using the Ctrl+N. By examining the executable's imported

functions we can often decipher the malware's functionality. Microsoft's MSDN API
documentation site (www.MSDN.microsoft.com) can be a useful resource for finding out

what these functions do, the parameter’s these functions take in, and what these

functions return.

From the Names window, if we right click on the function names we can set a breakpoint
by clicking on Toggle Breakpoint or F2.
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[Tpe (K] ame

Am&hTh read input
_BringWindowToTop

import (K| LUSERIZ BroadeastSyste m Message W'
lmport (K| KERNELIZ CloseHandle
Impert oled?.C oC reate Insmnce
2.Cobnitialize

132 CompareStingh
L3 CompareStringW
32, CopyFileW

oled2.CoTaskMem Free

Import  |ole32.C reateClass Moniker
(K USERIZC reateDialog Indi rectParam\VW

L32.C reate EventW
CrenteFiled
L32.C reateFile Mapping W
C renteFileW
32.C reate M utexMV
32.C reateProcessW
32.C reateThread
LT reate Windo wExW
?t" rypticgul reC ontextd

Del-gB reak
DefWindowP rocW
L32. DeleteC rticalSection
3'-‘ DeleteFiled

2. DeleteFileW

lenert (K115 EQ39 Destmulifindne
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Address | Section

DDAFT2FE |, rdata Import

004FTEFE | . rdata import

004FT300 |.rdata Import

B04FTEFE | rdata Iimport

004FT304 | rdata Import

DMFTINC |, rdata Import

004FT2FC | rdata import

DOAFTIOE |, rdata Import

B04FTIEC |.rdata import (K|LUSERIZ
DO4FTIS0 |, rdata Import (K US
DMFTITC |, rdata

DOAFTOED |.rdata

D04FT41E |, rdata

004FT48 | rdata Import oled
DOAFTZAD |.rdata Ilmport (K| KE =! NE
004FT2AE | rdata Import (K| KERNE
BAFTIDA |.rdata Ilmport (K| KERNEL
B04FTAIC | rdata Import

00AFTAL0 | rdata Ilmport ole32.Collninitialize
B04FT420 | rdata

004FT368 | rdata Import

BIAFTIAE | rdata lmport (K| KERNE
00AFTIFC | rdata Import (K| KERNEL3Z
DOAFTOFE |.rdata lmport (K| KERNE
D0AFTIDC |, rdain Import (K| KERMNEL32
004FTOAR | rdata Import (K| KERNEL
0O0AFT110 | rdain Import (K| KERNEL
00AFTOC | rdata Import (K| HKERNEL
BMAFTIBC |.rdata lmport

BOAFTO2C | rdntn Import

0O04FT028 |.rdata Ilmport

D04FT030 |, rdain Import

004ET20C | rdata Import (K HERNEL
00AFTIDE |.rdaia

O04FTLIC |, rdata

D0AFTICE |.rdata Ilmport (K| KERMNEL
O0AFTOEC |, rdatn Import (K| KERMNEL
DAAETI04 | redntn

|ﬁngram entiy point

| Paused
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Blx| 0| w4 EI LE|M|T|w|H|c|7|K[B|R|..|5| =[E]?

thread, module LaunchU3 =10l x|

I_IL

CALL LawnchU3 004CD6EI6 Registers (FPU) <
MOV EBX . EAX EAX 00000000
- T R - R1.EH X EC X T6T0F33A
4cFDBH|. Backup B0 ED X 0033FEFD
ORACFDCZI | MEB GFDEFI - EEX TESASFFS KERMEL3IZ. TEBASFH
> 2
DeACFDCT|| NBFO Copy ESP 0033FETA
oeac EDCa||. A T0424 01 . - EB P 0033FESE
ppac roDo| | nes 6psrs  Einary » ES1 7EED FO000
ggg Egg? ':!BD F Bssenﬂa Spae EDIV0ACDITZ LaunchU3, <Module Er
oAC FDDE| | N34S B4 LEIJB' ' [].EaX EIP 004C D972 LaunchU3. <« ModuleEr
004C FOD H |.OwFea 33010 .
a C 0 ESO00TE 32bitO[FFFFFFFF
poac ro el || MBET Comment ; e N
04CFDES ||.DvFB4 2801 E:r'r:-.-al-'.;_u:uirlt IDIJIJIE F2 jt 0[FFFFFFEF)
Sgg Eg E!a -I:'::I?ITHIIII‘. Hit, k. » ditional Shift+F2 P FFFFEEER) |
. aCE ar + 0
4CFDFL([. N93E g _ o :un[.':cél]
ooac E0E3 || nsce Fun trace »  Conditional log Shift-+F4
. Run ko selection F4 ROR_SUCCESS (00
Mew origin here Crl4+Gray O ,NB ,NEANS,PO,
Goto P Memory, on access
- FRMNEL32.7B85B:
::;m ::';‘u‘;u';l; . Follow in Dump P Memory, on write =
00532008 |26 62 4F 00 View call tree Crl+K i
00532010 |63 62 AF 00 & Hardware, on execution e
1 A1l 4
S ?‘15; """ searchfor P| |oossFess |possrecs
I oo FEB T TO0F |RETUR KERN 2.1885C"
00532028 | FF 62 4F 00 Find references to » gg;gr_ggg ?E:Eﬁcga TN DL e i
00532030 | 1F 63 4F 00 ;
00532038 SC 63 4F 00 Yiew '- 0033FESd ||004ACD972 | LawnchU3. <Module EntryPoint>
: . 0033FEE | Jovoonoon
00532040 TC 63 AF 00
sossz0as |massargs  COPYtOexecutable P |o03sFEsc |Jeeonoooe
00552050 |DAGI4F 00 Analycie [ B Pt M |
00532058 18 614AF 00 3 r b E'Ta oL -
AREYINES |48 EA AT ART Boaokmark [ 3 DO3SFEAS |Jodoooood e

\Analysing LaunchU3: 4 _ [nown, 5528 calls to quessed functions | |Paused

OllyDbg’s Memory Map window shows the virtual address, the virtual size, the owner
module, section names, memory allocation type and memory protection for each
allocated region of memory in the process.
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(Sl x| wn| wils ¥4 M + v[E[m|T|wB|c|/|K|B[R[.S]| E[iH]?]

bddress | Size  (Del Owner Ilui-un Contins Ilut Access Initial ace Mapped as -
00110000 |00020000 ( a0l Priv 0| RW R =
00220000 | 0000 LDOD (4 9022 Priv | RW RWW vt
00221000 | 00001000 (4 ooz21 Priv 0| RW R
00230000 | Q00O LOOD (4 IGZS* Priw 0| RW RWW
00240000 | 00002000 (8 LI Privid R
00242000 |QDOFED0OD [ Iﬂ'm stack of main 1 Priv D R
00360000 | 0000 LOOO (4 o036a Frivd RW RW
00370000 | OOODOLOOOD (4 o037 Priv | RW R
00350000 | 00005000 (4 d039a Privi RW RW
003AD000 | QOOD23000 ( 003, Priw 0| RWW RW
00400000 | 00001000 (4 LawnchlU3 PE hender Imag | R RVWE
0040 1000 | 000 FE00D [ | LawnchlU3 | text code Imag | R RWE
BOAFTOO0 | Q003IBO00 (| LawnchlY | . rdate imports Imag | R RWE
00532000 | QODOCOO0 [{ LawnchUld | data data Imag | R RWE
QOSIECOD | Q000B00D ({ LaunchUY |.mme reIoures Imag | R RWE
00545000 | 00010000 (g L1 Priv 0| RV RW
TE&10000 | 00001000 (4 KERMNEL32 PE hender Imag | R RWE
TES811000 00001000 (4 KER NEL!#.E“ code Imag | R RWE
TES12000 | 00001000 (4 KERMELIZ.mloc relocations Imag | R RWE
TES813000 (00188000 (] KERMEL3Z .rsrc rESources Imag |R RWE
TES3E000 | 0009F000 (§ KERMNELY Imag | R RWE
TEC 10000 [ 00001000 (4 nedll 755 PE header Imag | R RWE
TBC 11000 | 0000 1000 (4 nedll TBC.tewt code Imag | R RWE
TBC 12000 [ 00001000 (4 ntdii 735 .reloc relocations Imag | R RWE
TEC 13000 | 00001000 (4 ntdll TBC.rsrc rESoNIGES Imag | R RWE
TBC M000 | 000CO000 ((nedll TB Imag | R RVWE
TOFEOODD | 0000 1000 (4 wxtheme PE header Imag | R RWE
TOFBLO00 | Q0001000 (4 wxtheme T.text code Imag | R RWE
TD FE2000 | 000D 1000 (4 wictheme .meloc relocations lnlg R RWE
TDFB3000 |00001000 (4 uxtheme s resoMrces Imag | R RWE
10 FEA000 | 00024000 (| wxtheme T Imag | R RWE
TEQANODD | 00001000 (4imm32 TI PE header Imag | R RWE
TEQALVDD |0DOO L1000 (4 imm32 T1 LTENt code Imag | R RWE
TEQAZODD |(00001000 (4imm32 Tl.reloe relocations Imag | R RWE
TEQAIIQD | 00001000 (4 imm32 T1 .TSEE TESouIGES Imag | R RWE
TEQAL000 | 000 L2000 (Yimm32 TI Imag | R RVWE
TEZE0000 | Q0001000 (4 winexll T‘ PE header Imag | R RWE ll
TEIRINAD | AOND MAN (S wimewl] T tewr warle Imar | B BVWEF
Program entry point | Pavsed

OllyDbg’s Threads window shows the thread ID, Entry Point virtual address, the Thread
Environment Block (TEB) virtual address, the last-error value, status such as, active or
suspended, the priority, and the timing information for each thread in the process.

Ident

Entry

Last error

Priority

=10 x|

Usertime | &

00000037 (o

04C D972

TFFDEDDD

ERROR_SUCCESS (0

Active

32 +0

0.0000 =

=l

The Windows window displays the Handle, Title, Parent Window, Window ID, Window
Style, and Window Class Information for each window owned by the process.
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Hundle Title Parent WinProc | ID { Style ExtStyle |Thread | hl

|

The Handles window shows the object type, reference count, access flags, and the object
name for each handle owned by the process.
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Huandle '_rn:l Refs |fccess T | Info Name

The SEH (Structured Exception Handler) chain window shows the Structured Exception
Handler functions for the current thread.

File Wiew Debug Plugins Options Window

llil«lxl s RS ETE _I LlE|MT|w|H|c|/|K|B|R]...| 5] =_=I-_-'|_|
-1l x|

Address SE handler
0033FEF) |ntdll.TECBC3IBO




Breakpoints

One of key features of any debugger is the ability to set breakpoints. A breakpoint
enables us to stop the execution of a program at a specified address or instruction. There
are two primary types of breakpoints (1) software and (2) hardware. OllyDbg provides a
way to view and turn on and off breakpoints via the breakpoints window with Alt+B

File Yiew Debug Plugins Options Window Help

4 CPU - main thread, module LaunchU3

T

- .’.' ',"
. EAX 00000000
ECXT6T0F33A

ED X 0033FEF0

W
Blx] »u] v+ g1 A L]E[m]7|w]n]c|s|x]BR]-s] t=E?

e rs (FPU)

bl

MOV D\Nb RD PTR SS:[EBP-20],EBX

10/

RMEL3I2.7TBBASFH

nchU3.<ModuleEq
nchUS. <Module Ery

k O(FFFFFFFF)
O(FFEFFEFF)
O( FFEEEFEF)

k O( FFFFFFFF)
0(0)

k 0(0)

DPR_SUCCESS (00
.MB_NEANS PO

|

e

FNELSZ78856: 4 |



OllyDbg Frequently Used Shortcuts

Ul

Open new program F3

Close program Alt+F2
Maximize/restore active windows F5
Make OllyDbg topmost window Alt+F5
Close OllyDbg Alt+X

Windows

Open breakpoints window Alt+B
Open CPU window Alt+C

Open modules window Alt+E
Open log window Alt+L

Open memory window Alt+M

Editing

Add label : (Colon)

Add comment ; (Semicolon)
Edit memory Ctrl+
Assemble Space

Undo changes Alt+BkSp

Execution

Step into F7

Animate into Ctrl+F7

Step over F8

Animate over Ctrl+F8

Run application F9

Pass exception handler and run Shift+F9
Execute till return Ctrl+F9
Execute till user code Alt+F9
Trace into Ctrl+F11

Trace over Ctrl+F12

Pause F12

Pause trace conditional Ctrl+T
Run to selection F4

Breakpoints

Set/Unset breakpoint F2

Set/Edit conditional breakpoint Shift+F2
Set/Edit conditional log breakpoint Shift+F4
Temporarily disable/restore BP Space



Data

Analyze executable code Ctrl+A
Scan object files Ctrl+0
Display symbolic names Ctrl+N

Searching

Find selected address xrefs Ctrl+R
Find jumps to line Ctrl+]

Search for sequence Ctrl+S

Search allocated memory Ctrl+L
Search binary Ctrl+B

Search for a command Ctrl+F
Repeat last search Ctrl+L

Navigation

Go to origin * (Asterisk)

Go to address of expression Ctrl+G
Go to previous address - (Minus)
Go to next address + (Plus)

Go to previous procedure Ctrl+-
Go to next procedure Ctrl++

Go to previous reference Alt+F7
Go to next reference Alt+F8
Follow expression Ctrl+G

Follow jump or call Enter

View call tree Ctrl+K

Miscellaneous

Context sensitive help Ctrl+F



Complete List of Shortcuts

The following is a complete list of OllyDbg shortcuts from OllyDbg's official website
www.ollydbg.de and visit the Quick start section.

Functions

0
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[Gopr chamges 12 evecstable B
ﬁxmm
i stpe et s vt

[Virue pracustes

[sespund servme deead
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Global Shortcuts
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